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Welcome to OctaneRender™ for Carrara®.

OR4C 1

The following video is by Orion_uk

Features
Integrated Environment
- Texture (HDRI)

- Daylight
- Texture + Daylight

Integrated Camera

- Thin Lens and Isomorphic
- Stereo Rendering

Integrated Materials

- Octane Materials can be configured while preserving original Carrara Shaders
- Works with internal or external texture maps.
- All current Octane 2.0 Materials and Textures are supported.

Conversion of existing Carrara Shaders

- Reasonable conversion of Multi Channel shaders which take into account
- Color

- Alpha

- Highlight

- Shininess

- Bump

- Reflection

- Transparency

- Refraction

- Glow
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The following Shaders are directly converted to Octane Shaders
- Color

- Color Gradient

- Index of Refraction (in Refraction Channel)

- Texture Map

- Value (0-100 and (0-10000)

- Mixer

- Multiply

- Checkers

The following shaders are mapped but don't produce the same result
- Add (mapped to Multiply)

- Marble

- Fractal Noise (mapped to Rigid Fractal)

- Turbulence

External Render Window

- Displays the Octane Render View Port (ORVP)
- Shows stats for the current render

- Updates when changes are made in Carrara.

- Provides:

- .ocs and .orbx exporting

- Image saving

- Diagnostics

- Pause and Resume render

- Lock render from updates from Carrara

- White Point picker

- Material picker

- Focus picker

- Restart render

- Free Camera mode.

- Can zoom and pan image.

- In free camera mode you can control the camera view in the same way as the standalone (pan, zoom, rotate).

External Settings Window

- Set the render target settings including

- Imager

- Kernal (DL, Path Tracing, PMC, Info Channel)

- Post Processing

- Render Target setting are saved and loaded seperately from the .car file (at this time)
- Animation

- animations rendered to image sequences

- camera motion blur

- Devices

- control which GPUs to use and their priority

- Octane Live DB

- download materials from the Live DB database and save them as Carrara browser files (.cbr)
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INSTALLATION

Hardware Requirements
Software Requirements
Internet Access
Installation Process

GPU Settings
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HARDWARE REQUIREMENTS

OctaneRender for Carrara requires a NVIDIA CUDA-enabled video card with Compute Capability 2.0 or above.
The official list of NVIDIA CUDA-enabled products is located at https://developer.nvidia.com/cuda-gpus.

OctaneRender runs on Fermi (e.g. GTX 480, GTX 580, GTX 590) and Kepler (e.g. GTX 680, GTX 690) GPUs, the high-end GTX780 and GTX
Titan. It also supports older CUDA enabled consumer video cards (Nvidia GeForce GT 400 series and up) but it will be subject to memory size
and speed limitations on those cards. Kepler GPUs allow a higher texture limit (256 compared to 128 on Fermi) and are also more power
efficient and more silent than Fermi cards. GPUs from the GeForce line are usually higher clocked and render faster than the more expensive
Quadro and Tesla GPUs.

GeForce cards are fast and cost effective, but have less VRAM than Quadro and Tesla cards. OctaneRender scales perfectly in a multi GPU
configuration and can use different types of Nvidia cards at once e.g. a GeForce GTX 460 combined with a Quadro 6000.

@ Otoy, inc. 2012 All Rightz Resenved.
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SOFTWARE REQUIREMENTS

The plugin requires OctaneRender Standalone Edition to be installed and activated. The Standalone Edition does not need to be the same
Octane version as the plugin — since they operate separately.

CARRRRA 8

The plugin supports Carrara 8/8.5 Pro or Standard, 64 or 32 bit for Windows.
OctaneRender for Carrara is available for the following operating systems:

= Windows 7, Windows 8, Windows 8.1 - 64 or 32 bit
The OctaneRender for Carrara plugin uses the Microsoft Net 4.5 or greater framework.
Note that it is highly recommended that you use a 64 bit addition of Carrara because it can take a lot of memory to load scenes into Octane.

OctaneRender requires a Nvidia driver supporting CUDA 5.5 (http:/mww.nvidia.com/download/index.aspx?).

B Otoy, Inc. 2013 All Rights Resenved.
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PLUGIN ACTIVATION

@otoy

The OctaneRender™ for Carrara plugin requires internet access to launch the first time. Internet access is not required to use both
OctaneRender™ and OctaneRender™ for Carrara plugin. When no internet access is present, the Live Database will not be accessible.

Upon launching the plugin for the first time, the user will need to log in to their OctaneLive™ account which is associated with their forum log-in

information. This information can be found in the customer section of the OctaneRender™ website.

All subsequent renderings will not need log in information entered.

Your OctaneRender license can only be active on one machine at a time. If you wish to transfer your license to another machine, you will have to
deactivate it on the current machine and reactivate it on the other one, (re-activation might cause a slight delay). In case of difficulty, contact

us here.

To activate the OctaneRender for Carrara plugin, please do the following.

m Start Carrara and load a scene (new or existing.)

m Select the [Edit -= Octane Commands -= Open Octane Render Window] menu item.

(=618 View! Insert,  Angimation, Windows: Web  Helg

Undo Change Scene Component  Cir+Z |70
Gan't Rado oy R

| Cut Chrl+X
Clr+C
Chil+V

Remove Unused Masters
MNew Master Shader

Duplicate
Duplicate With Symmedtry...
Flip..

Select All

Select All Primitives

Edit Scene Effects

Group
Unaroup
Spiit Object
Align...

Send to Origin

Centar Hot Paint
Paint Al

Environment Lighting

Master Liaht

Add New Anyihing Glows Light
Connect Anything Glows Liaht

Browser

» Select the Octane Live tab.

r Targ ettin
KHJDksdfiKJd
(sssesssmsmes |

» Enter your Octane Live ID and password and then select Activate.

= You should then shutdown and restart Carrara.

© 0O X
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Ensure Carrara is not currently running on your PC, and then run the provided installation file (octane_carrara_x64_[version number].exe). Select

l Installation Process A g g g f £ : 2
; the install directory of your Carrara installation. The installer will copy all the plugin files into the appropriate place.

= GPU Settings

u Using the Integrated Carrara Plugin Once installed, when you next run Carrara, the plugin will be available from the Edit menu.
n OctaneRender Viewport (ORVP)
= Render Settings You will need to activate the plugin prior to using it for the first time.

= Image Size o
m Start Carrara and load a scene (new or existing.)

.
C-ar;:i:? Lens » Select the [Edit -= Octane Commands -> Open Octane Render Window] menu iterm.
= Panoramic » On the viewport menu select Render Target Settings. (The third icon.)

= Emvironment » Select the Octane Live tab.
: ?:}ilﬁzt = Enter your Octane Live ID and password and then select Activate.

e T = You should then shutdown and restart Carrara.

gl Gl Once activated, you can start using the plugin to render.
» Using Carrara Materials

= Octane Materials

» Converting Carrara Shaders

= Octane Live DB ® Otoy; Inc. 2013 All Rights Resenved.

= Geometry
= |nstancing
n Trees
= Optimizing Mesh
= Object Layer
» Animation

= Change History
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GPU SETTINGS

The CUDA Devices tab is located on the Devices tab of the Render Target Settings dialog.

» Select the [Edit -= Octane Commands -> Open Octane Render Window] menu item.

= On the viewport menu select Render Target Settings. (The third icon.}

You can enable or disable your CUDA Devices from this window.

The render priority option can throttle down rendering on one or more GPU's to improve system responsiveness especially when rendering on a
GPU used for the display.

If you are using a single card for both CUDA rendering and as your Windows display adapter, it is recommended that you tick the priority
checkbox.

CUDA Devices configuration is stored locally on your machine and is session persistent. When transferring assets along with .skp scene file to
another machine all CUDA Devices configs are not being transferred and have to be reconfigured.

For troubleshooting problems, please refer to the Troubleshooting section in the OctaneRender™ Standal Edition User
Manual

B Otoy, Inc. 2013 All Rights Resened.
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The OctaneRender Viewport is where the rendering of the scene takes place. It is accessed from the Edit menu in Carrara.

)‘;- File: B=GIl Wiew: nsert  Animation  Windows, Web)  Help

= Using the Integrated Carrara Plugin Undo Channa Soane Camponant
in OctaneRender Viewport (ORVP) / Lyt Hedo
= Render Settings 3D L == Y900 Interface | Physics | Filters
= |mage Size 2 S
MNone
= Camera
. None
] Thm Lgns Remove Unused Masters
i MNew Master Shader
= Panaoramic
) Duplic Ctd+D
= Emvironment Duplicate With Symmetry...  Glr+Shift+D
= Daylight A
ST : Select All Clrl+A
Select All Primitives Chrl+Alt=A
® Sun + Texture
Edit Scena Effects Clrl+Shift+T
s
Materials iR —r
= Using Carrara Materials Unaroup Clrl+U
- e Spit Object
Octane.[v]aterlals s Gk
» Converting Carrara Shaders B )
fi Send to Origin Cirl+Shift+0
» Octane Live DB iy Ii Center Hot Point Clrl+ Al
Rl Foint Al Ctri+M
= Geometry
- Environment Lighting
® |nstancing
n Trees

= Optimizing Mesh
= Object Layer

= Animation

= Change History

21 ociane Commands

OctaneRender™ for

SEPREE NMOOCOO| & AF| © = [m

Sipx, 48.46 Mslsec, |1 Texiures 8 Triangles, 0 Displacement, 0 Hairs, 2 Meshes, GeFor X TITAN, 14/5099

Panning and Zooming

You can pan the image by pressing the <CTRL= key while dragging the image.

You can zoom the image by pressing the <CTRL=> key and scrolling the mouse wheel or by pressing the <CTRL> and <ALT> key while dragging
the image up or down.

Menu Bar
From the menu bar you can perform the following:
& Load RenderTarget — Loads the render target from a .ocs file.
B save RenderTarget — Saves the render target to an .ocs file.

Mote that the render target setting for the Imager, Kernel, and Post Production are not currently saved as part of a Carrara Scene file (.car). You
need to load and save the render target settings separately. This will be addressed in the near future.

&5 Settings — Opens the Octane settings dialog.

Save Image — Saves the current image to disk.

£ Export Scene — exports the current scene to disk as either an .ocs or an .orbx file.

L) Open Diagnostics Window — opens the Octane diagnostics window.

(0 Restart — Restarts the current render.

® Resume — Resumes the render if it was paused.

@ Pause — Pauses the current render.

@ Stop — Stops the render and clears the scene from the Octane buffers (including the current image).

=

= Lock Scene (toggle) - Lock the current scene from changes made in Carrara. Allows you to make changes in Carrara without affecting the
current render.

B white Point Picker (toggle). Allows you to set the white point of the scene by clicking on the render.
Material Picker (toggle). Allows you to switch to the shader room for the selected texture.

# Set Focus Point (toggle). Allows you to set the focus point for the Camera.

M Auto Focus (toggle). Allow you to enable or disable the Camera auto focus.

Reload scene. Reloads the current scene into Octane. May be useful if the ViewPort fails to pick up a change you made in Carrara.

Reset Image Pan/Zoom. Resets the image in the viewport to its original position and zoom level.

™ Free camera mode (toggle). Enters free camera mode where you change navigate the scene in the viewport in the same way as the Octane
Standalone.

m |Jse left click and drag to rotate.
= Use right click and drag to pan.

= Use the mouse wheel or the <ALT> key + left click and drag to zoom.

B camera Target Picker (toggle). Only available in free camera mode. Allows you to pick the target rotation point of the camera.

MNate that the free camera mode has no effect on the camera in Carrara. Leaving free camera mode will restore the viewport to the render
camera.

@ Otoy, Inc. 2013 All Rights Reserved.



#octanerender" ®otoy

= |ntroduction
= |nstallation
= Hardware Requirements RENDER SETT'NGS
= Software Requirements
® Plugin Activation
» Installation Process
n GPU Settings
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» (OctaneRender Viewport (ORVP)
l Render Settings

= Image Size Render Target

The Octane Settings dialog is where you can make changes to the Render Target Imager, Kernel, and Post Processing settings. Additional tabs
allow you to generate an animation, setup your GPU devices, register your plugin, download LiveDB materials, and configure preferences.

= Camera

= Thin Lens

:

= Panoramic Direct Lighting Kernel ~
= Emvironment

= Dayhght Ambient Occlusion -

ERlcxturs . ———

® Sun + Texture '
= Materials - =

= Using Carrara Materials

= Octane Materials

» Converting Carrara Shaders
= Octane Live DB

A

= Geometry
= |nstancing
= Trees
= Optimizing Mesh
n Object Layer
= Animation

= Change History

Post Processing

Please refer to the Octane Standalone documentation for the meaning of all the Render Target settings.

Mote that the render target settings for the Imager, Kernel, and Post Production are not currently saved as part of a Carrara Scene file (.car). You
need to load and save the render target settings separately. This will be addressed in the near future.

CiUsersiSimon\ideosBlurtest ||

The Devices tab is used to configure you GPUs. Please refer to the GPU Settings section for further details.

The Octane Live tab is used to activate the plugin. Please refer to the Plugin Activation section for further details.

Octane Live DB
AUsers\Simon'\Documents\DAZ 3D\Carrara 8.5\My Presets\My ShadersiLive DB .|

The Octane Live DB tab is used to download Octane material shaders from the Octane Live DB database. Please refer to the Live DB section
for more details.

Preferences is where you can tweak the behavior and look of the plugin.

Auto Start Render: Determines whether the render starts as soon as you open the viewport. If this box is unchecked then you need to press
the Resume (Play) button on the Viewport menu bar to start the render.

Render View Font Size: determines the font size of the viewport status bar.

Settings Font Size: determines the font size of the settings dialog.

@ Otoy, Inc. 2013 All Rights Reserved.
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The size of the image rendered by the plugin is configured in the Carrara Render Room on the Output tab.

» Using the Integrated Carrara Plugin
= OctaneRender Viewport (ORVP)
n Render Settings

- Image Size

= Camera
= Thin Lens
= Panoramic
= Emvironment
= Daylight
= Texture
® Sun + Texture

= Materials

» Using Carrara Materials

= Octane Materials

» Converting Carrara Shaders
= Octane Live DB

Only the Width and Height fields have any effect on the rendered image.

= Geometry
= |nstancing éc}m incs émiﬁf@ﬂ& Recerved.
n Trees
= Optimizing Mesh
= Object Layer

» Animation

= Change History
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The OctaneRender for Carrara plugin uses the position and orientation of the current Render Camera in Carrara.

» Using the Integrated Carrara Plugin
= OctaneRender Viewport (ORVP)
n Render Settings
= |mage Size

= Camera
= Thin Lens
= Panoramic

= Emvironment

= Daylight Thin Lens

= Texture

= Sun + Texture Panoramic
= Materials

» Using Carrara Materials
= Octane Materials

: @ Otoy, Inc. 2013 All Rights Reserved.
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Camera 1 : Camera

Motion  Modifiers Effects

The plugin will use the Carrara settings for the lens size to determine a Field of View that matches the Carrara Production Frame.
The plugin will also use the Carrara Distance to Near Plane setting to set the Octane Near clip depth.

HEéV EENO000O6|

Camera 1 : Camera

Motion ~ Modifiers  Effects

Camerat |

The plugin will use the Carrara setting for Zoom to determine a field of view that matches the Carrara Production Frame.
The plugin will also use the Carrara Distance to Near Plane setting to set the Octane near clip depth.

There are two ways that you can control Depth of Field in the plugin. You can either use the Carrara Depth of Field effect, or you can use the
Focal Depth and Aperture settings in the Octane Thin Lens effect.

Camera 1 . Camera

Mot Modifiers

To control the depth of field using the Carrara Depth of Field effect you need to Enable the effect and then open the DoF editor by pressing the
Edit button. Note that the Aperture, Auto Focus, and Focal Depth settings in the Octane Thin Lens effect are ignored while the Carrara Depth of
Field effect is enabled.

When using the Carrara Depth of Field effect the Focus setting controls the field depth and the Blur Intensity controls the aperture. All other
settings are ignored by the plugin.

NOTE: In Carrara, depth of field is optional, in Octane it is always enabled. To achieve a near infinite DoF you should set the Aperture setting in
the Octane Thin Lens effect to zero.

Additional settings can be set for the Octane camera using the Octane Thin Lens effect.

Camera 1 : Camera

Motion = Modifiers

Please refer to the Octane Standalone manual for further details on these settings.

The Octane Thin Lens Camera with the anaglyphic stereo effect enabled.

& Otoy, Inc. 2013 All Rights Reserved.
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The plugin will use the Carrara settings for the Zoom to determine a Horizontal Field of View that matches the Carrara Production Frame.
The plugin will also use the Carrara Distance to Near Plane setting to set the Octane Near clip depth.

Additional camera settings can be set in the Octane Panoramic effect.

@ Otoy, Inc. 2013 All Rightz Rezened.
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Daylight

Texture
» Using the Integrated Carrara Plugin

= QOctaneRender Viewport (ORVP) Sun + Texture
n Render Settings
= |mage Size
= Camera

= Thin Lens B Otoy, Inc. 2013 All Right= Recerved

= Panoramic

- Environment

¢ = Daylight

» Texture

® Sun + Texture

= Materials
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Daylight in the Octane plugin is achieved by setting Carrara's Atmosphere to Realistic Sky.

= |mage Size

= Camera
= Thin Lens
= Panoramic

= Environment

in Daylight
= Texture
® Sun + Texture

» Materials The position of the sun is set using the Realistic Sky properties. You can either use the sun position ball or set time/space coordinates using the
= Using Carrara Materials advanced button.
= Octane Materials
» Converting Carrara Shaders
n Octane Live DB
= Geometry
= |nstancing
n Trees
= Optimizing Mesh
= Object Layer
= Animation

= Change History

The position of the sun can also be controlled using Carrara's Sun Light widget.

Additional daylight options can be set using the Octane Environment scene effect.

See the Octane Standalone Manual for details on the daylight settings.

@ Otoy, Inc. 2013 All Rightz Rezened.
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TEXTURE

Carrara supports a number of background options. The options supported by the plugin include Color, HDRI, and Map.

terface

You can rotate the background image by setting the Z Rotation override checkbox and adjusting the Z Rotation slider.
You can adjust the Gamma of the background image by setting the Gamma override checkbox and adjusting the Gamma slider.

You can also completely override the background texture and create your own texture from the available Octane texture nodes.

vironment

Gotoy
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USING CARRARA MATERIALS

The OctaneRender for Carrara plugin will do its best to convert existing Carrara Shaders to Octane Materials. It does this be examining the
various shader channels and calculates a best fit Octane Material for the shader. For a multi-channel shader the plugin considers the Color,
Alpha, Highlight, Shininess, Bump, Reflection, Transparency, Refraction, and Glow channels. The Subsurface Scattering, Translucency, and
Displacement channels are not considered by the plugin at this time.

WARNING: Configuring the displacement channel in Carrara (not to be confused with the Octane displacement pin) can result in very high
resolution meshes being processed by the Octane plugin. This is due to the fact that Carrara applies the displacement to the mesh before
delivering the mesh to Octane for processing. Caution should be used when using Carrara's native displacement channel.

Shaders that are supported by the plugin include:

= Color

u Color Gradient

= Index of Refraction (in Refraction Channel)
m Texture Map

= Value (0-100 and (0-10000)

= Mixer

u Multiply

= Checkers
The following shaders are mapped but don't produce the same result

= Add (mapped to Multiply)
= Marble
= Fractal Noise (mapped to Rigid Fractal)

= Turbulence
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OCTANE MATERIALS

Octane Materials can be defined directly within Carrara by adding an QOctane Material top level shader.
The Octane Material shader consists of two pins:

The Shader pin can contain a Carrara shader that will be used by Carrara in its native renderer.
The Material pin contains the Octane Material that you want to define and starts with any of the standard Octane Material nodes (Glossy, Diffuse,
Specular, Portal, or Mix)

With one exception, you can use the same nodes that you would use in the Octane Standalone renderer. Please refer to the Octane
Standalone Manual for details on creating Octane Materials.

For Image nodes (RGB, Greyscale, and Alpha) there is an extra pin where you can connect a Carrara Texture Map node.

The plugin will honor all of the Texture Map settings when the Use Texture Map Settings checkbox is set. Otherwise, only the image will be used
and any other settings will need to be done using the Octane nodes.

NOTE: Only 8 bit images are supported when using the Texture Map. If you want to use a 16 bit image (IES or HDRI for example) then you
should set the image using the Load button and set the Texture Map channel to None.
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CONVERTING CARRARA SHADERS

The OctaneRender for Carrara plugin does a reasonable job of converting Carrara shaders into Octane Materials. However, sometimes you
need to create your own Octane Material shader. For those cases you can start by converting a Carrara Shader into an Octane Material shader
and modify it to suit your needs.

To convert an existing Carrara Shader:

= Switch to the Assembly Room and select the object containing the Shader that you want to convert.

= From the Edit menu select Octane Commands -> Set Octane Materials.

This will convert all the materials attached to the object to Octane Material shaders. You can then switch to the material room and edit the
Octane Material as you see fit.

NOTE: This command only targets Multi-Channel shaders. If you have a Layers List that contains Multi-Channel shaders then all the Multi-
Channel shaders within the Layers List will be converted. Other types of complex shaders that contain Multi-Channel shaders may or may not be
converted.
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OCTANE LIVE DB

As part of your Octane license you have access to hundreds of community created materials. You can download these materials for use within
the OctaneRender for Carrara plugin.

From the Settings window select the Octane Live DB tab.

CilUsers\Simon\Decuments\DAZ 3D\Carrara 5.5\My Presets'My ShadersiLive DB !

Download All (594)
Downloading 5 of 15 materials.

From here you have the option of downloading the entire database or just the newly added ones. If this is your first time downloading then you will
need to download them all.

NOTE: A future update will allow you to download individual materials.

Once you have downloaded the materials they will be available to use from the Browser and Shader Preset windows.

If you did not download to the default location then you will need to add the LiveDB directory to Carrara manually.

To do this, select the browser and then select the Shaders tab.

On the far right of the browser window select the File/Folder Menu button and then select Add Folder.

Navigate to the Live DB directory specified above and then select OK.

You should now be able find the Live DB materials listed in the Browser.

To update the browser after downloading new shaders, either restart Carrara or select Update Folder in the File/Folder menu.
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In Carrara trees are constructed as a single mesh for the trunk, branches, and twigs and one or more instance collections for the leaves. Taken
as an individual object this is a fairly efficient model. However, when used with a replication surface this can lead to out of memory conditions.
Octane is limited in the way it handles nested instances. Instead of true nesting it flattens out all nested instances into one expanded collection.
So a tree with 10,000 leaves replicated 10,000 times will result in a scatter array of 100,000,000 instances. Since each instance takes 48 bytes
of memory that would be 4.8 GB of memory needed to replicate the one tree.

To help manage the scattering of trees the plugin allows you to collapse the leaves and the tree into a single mesh. This usually allows you to fit
the tree and the instance array into memory. However, be warned, flattening a tree can also result in out of memory conditions depending on the
number and complexity of the leaves. In general, when you want to replicate a tree, keep it simple. Create single non-flattened trees for close up
shots and simplified flattened trees for replication in the background.
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six separate surfaces instead of a solid cube. In most situations this make little difference to the render. However, for rounded edges this makes
all the difference in the world. Rounded edges only works when the edges are shared between surfaces.
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= OctaneRender Viewport (ORVP) To resolve this issue the plugin allows you to optimize the mesh of an object by sharing all vertices that are in the same location. By defautt all
= Render Sellings primitive objects are optimized, all other mesh objects are not.
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» Camera Mesh optimization may not be appropriate in all cases. Sometimes you want hard edges and sometimes you don't. It is recommended that you
= Thin Lens only optimize mesh where you want to use edge rounding and the rounding is not working.
= Panoramic

To enable mesh optimization on an object, select the object in the Assembly Room, select the Effects tab, and locate the Octane Object section.
From there you can enable or disable mesh optimization.
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= Sun + Texture

= Materials sr—.a-_hn.;.MD"Dn
= Using Carrara Materials

= Octane Materials

» Converting Carrara Shaders

n Octane Live DB
= Geometry

= |nstancing

n Trees

- Optimizing Mesh

= Object Layer

= Animation

» Change History

Propartias

NOTE: Optimizing very large meshes can significantly affect the load time of the mesh into Octane. This may be of particular concern when
animating the mesh in question.
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» Sun + Texture The power of Carrara is in its ability to create animations. The OctaneRender for Carrara plugin can tap into this power to create an image
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o Once you have constructed an animation using the Carrara timeline you can render the image sequence by selecting the Animation tab of the

» Converting Carrara Shaders OctaneRender for Carrara Settings window.
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BlurTest
C:\Users\Simon\Videos\BlurTest -

= Change History

Frame: Select the frame where you want to start the rendering.
Starting Sequence # Here you can set the sequence number of frame zero. The Current Sequence # will be calculated from here.
Filename Prefix: Here you can set the prefix that will be used as the start of the filename for each image in the sequence.

Output Directory: The path to the directory that will contain the generated image sequence. Note that any existing images will be overwritten
without prompting if their flenames match.

Camera Motion Blur: If enabled the camera movement will be pre-calculated to produce the camera motion blur effect.
Render Single Frame: Allows a single frame to be rendered. This is useful to capture a single frame with motion blur enabled.

Save Image: When enabled the image is saved in the image sequence. When disabled the image must be saved manually using the Octane
Render View Port. This option can only be disabled when rendering a single frame.

Render: Starts / Stops the rendering of the animation sequence (or single frame).

Images in an animation sequence are rendered until the max samples defined in the Render Target -= Kernel settings are reached.
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CHANGE HISTORY

Changes in 2.06.0050

Added Plugin Version number to ORVP title bar.

The plugin now recognizes a Normal Map in the Bump channel.

Removed annoyance shader diagnostics from the log.

Added Estimated Time to Complete and Elapsed Time to the Animation Tab.

Changes in 2.06.0049

Attempts to fix ORVP stall issues (have had limited success) when using multiple projects in the same Carrara session.
Fix for animations not working with physics simulations.

Added reset render target settings button

Fixed ‘open image’ dialog appearing when you open the Settings window

Fixed disabling AF in ORVP not sticking in Carrara (unless you are in free camera mode)

@®oloy

CTRL-SHIFT-O remapped to CTRL-SHIFT-R (To avoid conflict with the vertex editor you can no longer open the ORVP when in the Model room.)

Fixed material settings not being animated in ORVP
Fixed sunlight widget (not the dialog) tracking in Carrara 8.1
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